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1 - Introduction
 

The Smart Temperature Relay Switch (STRS) provides switched control of user 
equipment based on specified trigger criteria. Useful in a vast array of applications, the 
STRS is designed to provide many years of reliable operation.

Companion Windows application software permits configuration of a variety of settings 
including trigger limits (temperature and/or relative humidity). The STRS communicates 
with the host PC via a USB-to-RS232 adapter cable (included). Once configuration is 
complete, the Windows application is no longer needed (unless logging is desired).

The STRS accepts wireless (RF) sensors as well as optional wired peripherals such as 
temperature-activated switches. (Virtually any non-voltage switch may be an acceptable 
wired input.) The system is expandable up to four (4) wireless sensors and four (4) wired 
switches. 

The STRS is ideally suited for any application where it may be necessary to evoke an 
action based on changes in temperature and/or relative humidity such as the following:

• Exhaust systems
• Farming & agriculture
• Climate control
• Greenhouse monitoring
• Environmental control
• Industrial automation
• Plant  & produce cultivation
• Freezer alarms & refrigeration systems
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1.1 - Features

 
The STRS provides an array of viable features and options:

• Configurable settings including setpoint triggers for temperature and/or relative 
humidity

• Four (4) LED indicators show trigger status: 

• Trigger-pending = solid red
• Trigger-active = flashing red

• Available low-cost RF sensors for remote temperature/humidity monitoring. 
Applicable temperature range listed below (Celsuis and Farenheit).

• -40 deg.C to 70 deg.C
• -40 deg.F to 158 deg.F

Note: Accurate to +/- 2 deg.F

• Applicable humidity range listed below:

• 1% to 99%

Note: Accurate to +/- 3%, +/- 5%

• Four (4) wired inputs for optional wired switches, thermostats, etc.
• Expandable up to four (4) RF sensors and four (4) wired switches
• Onboard Form-C relay (contact ratings: 10A @ 125VAC, 6A @ 277VAC, 5A @ 

30VDC)
• Windows host monitoring via USB (adapter cable included)
• DB-9F (female) connector
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1.2 - Trigger Activation

 
The STRS utilizes compatible wireless sensors for transmitting temperature and relative 
humidity measurements. You may define trigger limits values relevant to these 
measurements. For each desired sensor, a unique set of high and low limits can be 
configured.

Note: Limits may be defined for temperature and/or relative humidity.

A trigger activation occurs when a defined temperature or humidity trigger limit is 
breached. The violation can result in relay activation and/or piezo (beeper) annunciation, 
depending on your prescribed trigger settings.

Note: Optional wired switches may also be utilized to generate trigger activations.
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2 - Setup
 

Setup primarily involves the following operations:

• Install USB drivers (using the CD included with the adapter cable)
• Install STRS host application software (using download file “strs_setup.zip”).
• Connect the USB adapter cable (DB-9 end to STRS controller and USB end to 

the host PC)
• Connect the AC power adapter (barrel plug end to STRS controller and opposite 

end to a 110vac outlet).

Additional setup & installation details are provided in subsequent sections of this manual.
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3 - Wireless Sensors
 

The following Acurite wireless (RF) devices are compatible:

• 6002M -  Temperature + humidity, indoor/outdoor, a.k.a, 6002RM, 592TXR
• 6044M -  Temperature + humidity, indoor only, featuring LCD display
• 6053M -  Range extender/repeater, indoor/outdoor

Follow the instructions included with your Acurite device for installation instructions and 
operational details.

Notes:

• Acurite sensors typically include a channel select switch (A, B, or C). The STRS 
places no dependence on this setting. Therefore, you may choose any desired 
channel.
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4 - Wired Switches
 

WARNING:  Be sure that power is disconnected until all wiring has been completed and 
verified.  

The STRS controller accepts four optional wired peripherals such as push-button 
switches, temperature-activated switches, thermostats, etc. (Virtually any non-voltage 
switch may be applied to a wired input.) To apply your switch device to a wired input, 
perform the following operations:

• Disconnect the STRS power source.
• Detach cover by removing the retaining screws.  
• Locate the 14-position wiring terminal connector.  (Refer to TB-1 Wiring 

Connections.)
• Attach wires as necessary, being careful to utilize the proper wire slots. (Each 

switch has a designated input terminal and a return.)
• Replace the cover and secure with retaining screws.
• Restore power to the STRS controller.  

 
Note: Wired switch input(s) must be appropriately configured and enabled.
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5 - TB-1 Wiring Connections
 

The STRS controller provides a 14-position wiring block with the following screw 
terminal connections.

Terminal Description

1 +12VDC in/out

2 Ground

3 Reset (active-low)

4 Wired switch / thermostat #1

5 Wired switch / thermostat #2

6 Wired switch / thermostat #3

7 Wired switch / thermostat #4

8 Switch return #1

9 Switch return #2

10 Switch return #3

11 Switch return #4

12 Relay contact - COM

13 Relay contact - N/C

14 Relay contact - N/O

Notes:

• Only a subset of the above connections will be required in a given application.
• If supplying your own power source at terminals 1 & 2, do not also concurrently 

provide power with the ac adapter at the barrel connector.
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6 - Windows Host Software
 

Available STRS host software for Windows provides functionality for configuring trigger 
parameters as well as performing realtime monitoring. The following is a summary list of 
software features

• Establish trigger parameters
• Monitor sensor measurement

These are the requirements for installing the host software on your PC or laptop 
computer:

• Pentium or compatible CPU 
• 8 MB RAM 
• 1 MB available hard disk space 
• 1 available RS-232 or USB port
• Windows XP or higher
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6.1.1 - Device List
 

The device list shows a collection of detected sensor devices and their operating 
parameters.

Use the horizontal scroll bar to display additional data columns.

Each row corresponds to a particular sensor, while each column shows a specific detail or 
data parameter as listed below:

• Addr – numeric sensor address, displayed in hexadecimal format.
 

• Desc – user-specified description and/or location for the sensor.
 

• ID – device identifier (specified by the sensor manufacturer).
 

• Ch – channel code (selectable at the sensor).
 

• Batt – battery staus (“ok” / “low”).
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• Temp – temperature (reported in degrees Fahrenheit or degrees Celsius, depending 
on the selected temperature units).

Notes:

• Trigger-activated   temperature data will be indicated by a flashing (blinking) 
measurement reading.

• The application provides an automatic trending feature. When a trend is 
detected, the appropriate indicator is shown to the right of the 
measurement:

• > - indicates upward (increasing) trend
• < - indicates downward (decreasing) trend

• RH – relative humidity, a reading that occurs in the range of 0 to 100%.

• Trigger-activated   relative humidity data will be indicated by a flashing 
(blinking) measurement reading.

• The application provides an automatic trending feature. When a trend is 
detected, the appropriate indicator is shown to the right of the 
measurement:

• > - indicates upward (increasing) trend
• < - indicates downward (decreasing) trend

• Trig'd – reports whether the temperature and/or humidity measurement(s) have 
resulted in a trigger event (i.e., relay activation). One of the following indicators 
will be shown:

• “T” - the temperature has reached a high or low limit threshold, resulting in a 
trigger-ready condition (see note).

• “RH” - the relative-humidity has reached a high or low limit threshold, 
resulting in a trigger-ready condition (see note).

• None - the field is blank or empty when there is no trigger activation.

Note: A trigger-ready measurement is indicated by a reading that is shown 
flashing (blinking). Trigger-activation occurs when the following conditions  
are met for a trigger-ready measurement:

• Pre-trigger delay   has elapsed, if applicable
• Trigger activation is not already in progress (by another sensor)
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• Activity – numeric counter that increments for every data message received from 
the sensor.

Note: Activity counters are derived by the Windows host application. They are not 
initiated by the controller device.

• Time 1, 2, 3 – three adjacent columns of timestamp data. Each column records the 
time at which sensor measurements were captured. Time 1 is the most recent 
capture.

Note: Time values are derived by the Windows host application. They are not 
initiated by the controller device.

• Tr En. – trigger-enable indicates whether triggering is enabled for the specified 
sensor. One of the following indicators will be shown:

• “Y” -  enabled.
• “N” - disabled
• “?” -  triggering is not applicable for the designated sensor. This occurs 

when the sensor is not defined in one of the controller's list of  four 
available trigger slots.

• Tr Hi Tm – the high temperature trigger defines the upper limit temperature 
threshold. A trigger activation occurs when the current temperature rises to this 
level. Symbol “-” indicates the parameter is undefined, i.e., there is no high 
temperature limit.

• Tr Lo Tm – the low temperature trigger defines the lower limit temperature 
threshold. A trigger activation occurs when the current temperature drops to this 
level. Symbol “-” indicates the parameter is undefined, i.e., there is no low 
temperature limit.

• Tr Hi RH – the high humidity trigger defines the upper limit relative-humidity 
threshold. A trigger activation occurs when the current relative-humidity rises to 
this level. Symbol “-” indicates the parameter is undefined, i.e., there is no high 
relative-humidity limit.

• Tr Lo RH – the low humidity trigger defines the lower limit relative-humidity 
threshold. A trigger activation occurs when the current relative-humdity drops to 
this level. Symbol “-” indicates the parameter is undefined, i.e., there is no low 
relative-humidity limit.

• Tm Max - Min – this column displays the maximum and minimum temperature 
readings. 
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Note: Max / Min values are derived by the Windows host application. They are not  
initiated by the controller device.

• RH Max - Min – this column displays the maximum and minimum relative-
humidity readings. 

Note: Max / Min values are derived by the Windows host application. They are not  
initiated by the controller device.
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6.1.2 - Temperature Units
 

This check-box control selects the preferred units for displaying temperature 
measurements. Choose Fahrenheit (ºF) or Celsius (ºC).

For Celsius units, the box must be checked.

6.1.3 - Color-Coded Aging
 

The aging feature permits you to visually determine the relative age of displayed sensor 
data.

When enabled, each row of sensor data within the device list will be assigned a 
background color. If a new sensor data message is not received in a timely manner, its 
corresponding row color will automatically change to indicate the anomaly. Refer to 
Message Aging for color assignment details.

6.1.4 - Sensor Messages
 

When a sensor message is received, the data is displayed in the message field, shown 
below: 

Compatible sensors transmit data on a periodic basis, typically every 16 seconds. Each 
received data message contains the following elements:

• Sensor address (e.g., 3327)
• Channel (e.g., A)
• Temperature (e.g., 78.3 ºF)
• Relative humidity (e.g., 49%)
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6.1.5 - Application Status
 

The lower edit field contains status and event messaging.

One of the primary purposes for this field is to provide com port status. (Refer to Serial 
Com Port for details.)
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6.2 - Settings

 
The setting option provides fields for specifying the serial com port and message aging 
colors. The following menu item invokes program settings:

File → Settings...

6.2.1 - Serial Com Port
 

The com port selection enables communication with the STRS controller. 

Use the combo-box to select the virtual com port associated with your USB adapter 
cable.
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6.2.2 - Message Aging
 

The application receives periodic sensor messages from the STRS controller. These 
messages report temperature and humidity conditions along with other pertinent data. 
Message aging is useful for identifying possible sensor device issues. It permits you to 
choose appropriate colors (text and background) for identifying the age of sensor 
messages.

Newly received messages can be displayed in one chosen set of colors, while older (stale) 
messages can be shown differently. (Compatible sensors transmit data on a periodic basis, 
typically every 16 seconds.) Use the combo-box controls to select the desired text and 
background colors. You may also designate the desired aging time periods for old and 
recent messages.

In the listing below, the application has received new data from all sensors shown in 
green. However, the sensor designated at address 1A5D is shown in pink, indicating 
nothing has been received in more than 5 minutes. 

Note: Message aging is enabled with a check-box on the main display.
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6.3 - Controller Setup

 
The controller setup page establishes operating parameters for the STR device. It is 
invoked with the following menu item selection:

Tools → Controller Setup...

Individual field controls are described in subsequent sections.

Note: Settings are stored and maintained at the STRS controller. User changes and 
adjustments do not take effect until they are uploaded.
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6.3.1 - Audio / Visual
 

The STRS controller provides both audible and visual options for identifying trigger 
activity.

Field descriptions are listed below:

• Piezo Enable – this check-box enables audible beeper annunciation. When 
enabled, it permits the beeper to sound when a trigger activation occurs. Use the 
adjacent selector to choose the notification period. (The beeper will sound at this 
periodic rate until the the trigger activation event has cleared.)

Note: Piezo (beeper) annunciation requires appropriate trigger notification. See 
Trigger Settings for details.

• LED Usage – defines LED utilization. Four red LEDs are available at the STRS 
controller for the purpose of indicating trigger status for compatible sensors. Each 
LED corresponds to one of four possible trigger slots. Depending on the selection, 
they can be utilized to represent wired switches or wireless sensors:
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6.3.2 - Wired Switch Inputs
 

The STRS controller accepts up to four wired switch inputs. Wired switch activation has 
the same trigger activation effect as wireless temperature/humidity sensors. 

Each of the four available wired switch inputs may be utilized to evoke trigger 
activations. To enable one or more inputs, use the appropriate check-boxes. You must also 
choose the activation state that represents the applicable switch contacts:

• N/C – normally-closed contacts (i.e., activation occurs when the circuit opens)
• N/O – normally-open contacts (i.e., activation occurs when the circuit closes)

. Refer to the wiring terminal block layout for switch wiring details.
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6.3.3 - Trigger Settings
 

These settings permit you to define the behavior of trigger activations.

Relevant fields are described below:

• Source – defines allowable trigger activation source(s). Choose one of the 
following:

• Disabled – no trigger source
• Temp – temperature only
• Humidity – relative humidity only
• Tm / RH – both temperature and relative humidity

Note: The source field applies only to wireless sensors. It has no effect on wired 
switch inputs.

• Notify Mode – selects the action to perform in response to a trigger activation 
event. The following notifications are possible:

• None – no notifications
• Relay – activate relay
• Piezo – sound the piezo (beeper)
• Rly / Pz – activate the relay and sound the beeper
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• Deactivate Mode – Defines the preferred deactivation method. Deactivation occurs 
when a trigger activation event clears (i.e., the violating measurement returns to 
the normal, pre-trigger range). The following deactivation mode selections are 
available:

• Standard – Deactivate when the measurement returns to the normal, pre-
trigger range and remains so for a minimum time period specified by the 
post-trigger delay field.

• Automatic – Deactivate after the time period specified by the post-trigger 
delay field, regardless of whether the measurement has returned to the 
normal, pre-trigger range.

• Pre-Trig Delay – A pre-trigger delay is invoked following a measurement trigger 
limit breach. It is the time period that must elapse before trigger activation can 
occur. A trigger activation is invoked only if the breach endures for the entire pre-
trigger duration. Select a delay period in the range of 0 to 60 minutes.

• Post-Trig Delay – A post-trigger delay is invoked when a breached measurement 
returns to the normal, pre-trigger state. It is the time period that must elapse before 
the trigger activation event clears. The trigger activation event clears only if the 
measurement remains in the normal, pre-trigger state for the entire post-trigger 
duration. Select a delay period in the range of 0 to 60 minutes.

• Temperature Differential – Defines the minimum change in temperature that must 
occur below the trigger limit threshold before a breached measurement is 
considered eligible to return to the normal, pre-trigger state. It is useful in guarding 
against trigger toggling, an unwanted effect that occurs when the current 
temperature “hovers” at or near a trigger limit threshold. Without an appropriate 
differential, there can be repetitive trigger activation and subsequentdeactivation 
as the temperature fluctuates back and forth across the trigger limit threshold.

• Rel. Humidity Differential – Defines the minimum change in relative humidity 
that must occur below the trigger limit threshold before a breached measurement is 
considered eligible to return to the normal, pre-trigger state. It is useful in guarding 
against trigger toggling, an unwanted effect that occurs when the current relative 
humidity “hovers” at or near a trigger limit threshold. Without an appropriate 
differential, there can be repetitive trigger activation and subsequent deactivation 
as the humidity fluctuates back and forth across the trigger limit threshold.
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• Trigger Reset – Use this button to cancel an existing trigger activation or reset a 
pending one. Doing so deactivates the relay (if activated), and directs the STRS 
controller to a known, stable state. This function may be especially useful 
following settings adjustments.

Note:  If the measurement has breached a trigger limit threshold and endures in 
that state, then a trigger reset (cancel) has only a temporary effect. Until the 
measurement returns to a normal, pre-trigger state, a canceled trigger will simply  
re-activate.

• Upload – Settings changes must be subsequently issued to the STRS controller 
where they are stored and invoked. Use the upload button to transmit the field 
values to the controller. (Requires compatible USB-to-RS232 adapter cable.)

• Get – Use this button to retrieve (download) current settings from the STRS 
controller. Display fields will be updated accordingly. (Requires compatible USB-
to-RS232 adapter cable.)

• Exit – The exit button closes the settings page.
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6.4 - Sensor Properties

 
The Sensor Properties page provides the means to specify trigger activation attributes for 
your sensor(s). It is invoked with the following menu item selection:

Tools → Sensor Properties...
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There are four (4) available trigger slots. Each slot can be assigned a wireless sensor for 
the purpose of trigger activation. 

Notes

• Available sensors are shown in the device list at the bottom of the properties 
page. While the STRS controller can detect an unlimited number of sensors, 
only four (4) can be earmarked for trigger activation.

• Wired switches   may also cause trigger activations, but do not require trigger 
slot assignment. Refer to Wired Switch Inputs for details.
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6.4.1 - Sensor Description
 

Specify a descriptive label that identifies the sensor.

Relevant fields are listed below:

• Addr – This drop-down combo-box allows you to select the desired sensor. 

Note: Sensors are distinguished by unique address. Displayed in four-digit 
hexadecimal format, this numeric identifier is encoded by the device 
manufacturer.

• Desc –  Supply a description that identifies the sensor's purpose and/or location.

Note:  The description is a convenience intended to make sensor identification 
easier.
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6.4.2 - Trigger Limits
 

These controls permit you to set desired limits for specified sensor(s). Applicable to 
temperature and/or relative humidity measurements, breached limits invoke trigger 
activations.

Trigger slots support limits assignment for as many as four (4) wireless sensors. Create 
optional high and/or low limits using available fields.

Relevant fields are listed below:

• Slot – Use this check-box to enable or disable trigger activation for the given 
sensor. 

• Addr – This drop-down combo-box allows you to select the desired sensor. 

Note: Sensors are distinguished by unique address. Displayed in four-digit 
hexadecimal format, this numeric identifier is encoded by the device 
manufacturer.

• Label –  Identifies the sensor's purpose and/or location.
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• High Temperature (limit) –  Trigger activation occurs when the current 
temperature ascends to this value or above. (An unassigned value, indicated by 
“-”, disables the limit.)

Note: A breached measurement remains triggered until it returns to the normal, 
pre-trigger range and complies with the specified differential setting.

• Low Temperature (limit) –  Trigger activation occurs when the current temperature 
descends to this value or below. (An unassigned value, indicated by “-”, disables 
the limit.)

Note: A breached measurement remains triggered until it returns to the normal, 
pre-trigger range and complies with the specified differential setting.

• High Rel. Humidity (limit) –  Trigger activation occurs when the current relative 
humidity ascends to this value or above. (An unassigned value, indicated by “-”, 
disables the limit.)

Note: A breached measurement remains triggered until it returns to the normal, 
pre-trigger range and complies with the specified differential setting.

• Low Rel. Humidity (limit) –  Trigger activation occurs when the current relative 
humdity descends to this value or below. (An unassigned value, indicated by “-”, 
disables the limit.)

Note: A breached measurement remains triggered until it returns to the normal, 
pre-trigger range and complies with the specified differential setting.
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• Trigger Reset – Use this button to cancel an existing trigger activation or reset a 
pending one. Doing so deactivates the relay (if activated), and directs the STRS 
controller to a known, stable state. This function may be especially useful 
following settings adjustments.

Note:  If the measurement has breached a trigger limit threshold and endures in 
that state, then a trigger reset (cancel) has only a temporary effect. Until the 
measurement returns to a normal, pre-trigger state, a canceled trigger will simply  
re-activate.

• Upload – Settings changes must be subsequently issued to the STRS controller 
where they are stored and invoked. Use the upload button to transmit the field 
values to the controller. (Requires compatible USB-to-RS232 adapter cable.)

• Get – Use this button to retrieve (download) current settings from the STRS 
controller. Display fields will be updated accordingly. (Requires compatible USB-
to-RS232 adapter cable.)

• Controller Settings – Use this button to invoke the controller setup page.

• Cancel – The cancel button closes the properties page.

• Clear – Four (4) buttons are provided, one per trigger slot. Use the appropriate 
button to clear the slot fields, removing all content including sensor address, 
description, and limit values. 
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• Edit – Four (4) buttons are provided, one per trigger slot. Use the appropriate 
button as an alternate means to specify or adjust parameters including sensor 
description and trigger limits. When invoked, the following page appears:

Field details are provided below.
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• Supply a description that identifies the sensor's purpose and/or location.

Note:  The description is a convenience intended to make sensor identification 
easier.

• Choose a trigger slot for the sensor. There are four (4) available slots for trigger 
activation. Use the check-box to enable or disable trigger activation for the given 
sensor.

• Define trigger limit(s) for the sensor. (An unassigned value, indicated by “-”, 
disables the limit.)
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6.4.3 - Sensor List
 

Similar to the device list that occurs on the main page, this field contains a subset of 
columns, displaying primarily trigger-related parameters.

Using the left mouse button, single-click the desired entry to select a sensor. (You may 
double-click an entry to invoke trigger-slot editing.)

Use the “Delete...” button to remove an entry from the listing.

Note: The delete button remains grayed (disabled) until a sensor entry is selected 
from the list.
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6.5 - Forced Relay Activation

 
This option manually activates the STRS relay. It is invoked with the following menu 
item selection:

Tools → Activate Relay...

Several activation modes are possible:

• ON – Activate
• OFF – Deactivate
• Timed – Activates for the specified period and then deactivates.

Note: Forced relay activation is permissible only in the absence of a trigger activation.

35



6.6 - Enable Audible Alerts

 
Use this option to enable or disable audible alerts. If enabled, an alert is annunciated 
when a trigger activation occurs. It is invoked with the following menu item selection:

Tools → Enable Audible Alerts

Notes: 

• Audible alerts are sounded at the host computer and require suitable speakers.
• When the feature is enabled, a check-box appears beside the menu selection. 

6.7 - Enable Data Logging

 
Use this option to enable or disable data logging. If enabled, trigger events will be logged 
to ASCII data files for subsequent viewing. It is invoked with the following menu item 
selection:

Tools → Enable Data Logging

Log files will be stored to the following folder:

C:\Program Files\Smart Temperature Relay\Data\drpts

Notes: 

• Audible alerts are sounded at the host computer and require suitable speakers. 
• Trigger activation   events are captured and logged at the host application.
• When the feature is enabled, a check-box appears beside the menu selection.
• Logging is available only with the premium software package.
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6.8 - Log Preexisting Triggers

 
Use this option to log active (preexisting) trigger events. It is utilized in conjunction with 
data logging and is invoked with the following menu item selection:

Tools → Log Preexisting Triggers

When enabled, this selection will log active (preexisting) trigger events detected at host 
application start-up. 

Notes: 

• A preexisting trigger is an ongoing trigger activation that was initiated prior to 
host application start-up. 

• Logging preexisting triggers has the side-effect of storing duplicate instances of 
the same event. This easily occurs if the host application is terminated and then 
re-started during a persistent trigger activation.

• Trigger activation   events are captured and logged at the host application.
• Data logging   must be enabled before this option can be utilized.
• When the feature is enabled, a check-box appears beside the menu selection.
• Logging is available only with the premium software package.
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6.9 - View Data Logs

 
This option displays a history of logged trigger events. It is invoked with the following 
menu item selection:

Tools → View Data Logs...
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The upper set of controls comprise a filter for attaining a focused set of data results. 
Select the sensor device of interest and a range of dates.

The listing below displays data records that meet your prescribed filter settings:

Use the refresh button to update the record listing. Auto-refresh automatically updates the 
listing on a periodic basis.

Notes: 

• Auto-refresh updates the record listing every 10 seconds.
• Logging is available only with the premium software package.
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7 - ASCII Commands
 

The STRS controller accepts optional ASCII host commands on the RS-232 port (via 
DB9 connector). Commands are subdivided into the following types:

• Settings

• Assign general settings
• Assign RF sensor settings
• Restore default settings

• Peripheral activation

• Activate relay
• Activate beeper

• Miscellaneous commands

• Clear sensor states
• Report firmware version
• RF signal test

All commands are prepended with a special three-byte header sequence. The command 
header is shown below, indicated in both ASCII text and hexadecimal representations:

Command Header

ASCII Text
Numeric 

(Hex)

\SOH \STX > 01 02 3E

All transactions must be appropriately followed by a termination character as shown 
below:

Terminator

ASCII Text Numeric (Hex)

\CR 0D
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The example below illustrates a complete command sequence and is shown in both 
ASCII text and hexadecimal representations:

Command Example 
 

(Activate Relay)

ASCII Text Numeric (Hex)

\SOH \STX > ! 0 5 \CR 01 02 3E 21 30 35 0D

Notes:

• The command format contains no spaces. (Spaces are included in the example 
above only for clarity.)

• All command sequences must be preceded by the special 3-byte header. 
(Subsequent command listings have omitted the header for the sake of clarity.)

• Commands which assign parameter setting(s) also allow you to poll/retrieve the 
current setting(s). To do this, simply issue the command without parameters.

• Commands must be terminated with a carriage-return character (13 dec. or 0D 
hexadecimal). (Subsequent command listings have omitted the terminator for the 
sake of clarity.)

• Unless the command is to return a specific response, the reply will be “ok” if 
completed successfully. Otherwise, an error string may be reported.
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7.1 - Settings
 

Settings commands permit you to assign or retrieve those parameters designating 
operational behavior of the STRS controller. Available commands are listed below:

• Assign / Retrieve General Settings
• Assign / Retreieve RF Sensor Settings
• Restore Default Settings

7.1.1 - Assign General Settings
 

A number of general settings exist for the purpose of configuring STRS operational 
parameters. These settings can be set or retrieved at any time and include the following:

• Piezo-enable state
• LED usage
• Wired switch #1 input enable
• Wired switch #2 input enable
• Wired switch #3 input enable
• Wired switch #4 input enable
• Wired switch activation state
• Temperature differential
• Relative humidity differential
• Trigger type
• Activation type
• Trigger deactivation mode
• Pre-trigger delay period
• Post-trigger delay period
• Piezo annunciation period

The command format is defined below:

Command Syntax Comment

Assign General 
Settings (SGS)

SGSPzUsW1W2W3W4WaDtDrTtAtDmPaPiPp see below

Example: SGS1010001231310000600006001800
     

Description:
  

Pz=enabled, Us=wireless, W1=enabled, W2=disabled, W3=disabled, 
W4=disabled, Wa=open, Dt=23, Dr=1, Tt=both, At=relay, Dm=standard, 
Pa=60sec, Pi=60sec, Pp=1800sec
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• Pz = Piezo-enabled: 0=disabled, 1=enabled
• Us = Usage for the 4 red LEDs; 0=wireless sensors, 1=wired switches
• W1 = Wired switch #1 enable/disable; 0=disable, 1=enable
• W2 = Wired switch #2 enable/disable; 0=disable, 1=enable
• W3 = Wired switch #3 enable/disable; 0=disable, 1=enable
• W4 = Wired switch #4 enable/disable; 0=disable, 1=enable
• Wa = Wired switch activation state; 0=closed (normally-open), 1=open (normally-

closed)
• Dt = Temperature differential (2 digits); 0 – 99 (tenths of deg.C), default = 10
• Dr = Relative humidy differential; 0 – 9 %, default = 1%
• Tt = Trigger type (temperature, humidity); 0=disabled, 1=temp, 2=RH, 3=both
• At = Activation type (relay, periodic piezo); 0=disabled, 1=relay, 2=piezo, 3=both
• Dm = Trigger deactivation mode; 0=standard (sensor measurement must return to 

normal range), 1=auto (trigger deactivates automatically, even if readings have not 
returned to the normal range)

• Pa = Pre-trigger delay period (5 digits); 0 – 65535 seconds (default = 0). Trigger 
(relay activation) occurs if the sensor continuously reports readings that are 
outside the normal range for this minimum duration.

• Pi = Post-trigger delay period (5 digits); 0 – 65535 seconds (default = 0). A 
triggered activation is cleared (relay deactivated) when the sensor continuously 
reports readings that are within the normal range for this minimum duration.

• Pp = Piezo annunciation period (5 digits); 0 – 65535 seconds (default = 0). If non-
zero, this parameter enables periodic beeper annunciation which occurs at the 
specified period until the trigger clears. (Note: The piezo setting “Pz” must be 
enabled.)

Notes:

• Adjusting certain settings may yield undesirable effects when applied during a 
triggered or pending-trigger condition. Therefore, you are advised to apply the 
Clear Sensor States command immediately following a relevant settings change.

• To retrieve existing settings, issue the command with no parameters.
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7.1.2 - Retrieve General Settings
 

This command retrieves general settings. (Refer to Assign General Settings for parameter 
definitions.)

The command format is defined below:

Command Syntax Comment

Retrieve General 
Settings (SGS)

SGS Request general settings.

Example: SGS
  

Response:
 

Pz=0; Us=0; W1=1; W2=0; W3=0; W4=0; Wa=1; Dt=10; Dr=1; Tt=3; At=1; 
Dm=0; Pa=00060; Pi=00060; Pp=01800

Notes:

• This command uses the same mnemonic as Assign General Settings, but without 
parameters.
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7.1.3 - Assign RF Sensor Settings
 

This command permits you to assign/modify operational parameters associated with a 
specified wireless RF sensor. The request provides a means of defining trigger activation 
limits. These settings include the following:

• Sensor enable state
• Sensor address
• Sensor ID
• High temperature limit
• Low temperature limit
• High relative humidity limit
• Low relative humidity limit

The command format is defined below:
 

Command Syntax Comment

Assign RF Sensor Settings (STRS) STRSIxEnAdIdThTlRhRl see below

Example: STRS31123450040126001250060050
     

Description:
  

Ix=3, En=enabled, Ad=12345, Id=4, Th=1260, Tl=1250, Rh=60, Rl=50

• Ix = sensor index: 0 - 3
• En = enable/disable: 0 = disable, 1 = enable
• Ad = 14-bit sensor address (5 digits), 65535 = n/a
• Id = sensor ID (3 digits)
• Th = high temp. limit (5 digits), tenths deg.C, offset +100 to avoid negative 

integers, 65535 = n/a
• Tl = low temp. limit (5 digits), tenths deg.C, offset +100 to avoid negative 

integers, 65535 = n/a
• Rh = high relative humidity limit (3 digits), 255 = n/a
• Rl = low relative humidity limit (3 digits), 255 = n/a

Notes:

• Temperature and/or relative humidity outside the range defined by high/low limits  
constitutes a trigger (relay) activation condition.

• Adjusting certain settings may yield undesirable effects when applied during a 
triggered or pending-trigger condition. Therefore, you are advised to apply the 
Clear Sensor States command immediately following a relevant settings change.
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7.1.4 - Retrieve RF Sensor Settings
 

This command retrieves settings associated with wireless RF sensors. (Refer to Assign 
RF Sensor Settings for parameter definitions.)

The command format is defined below:

Command Syntax Comment

Retrieve RF Sensor 
Settings (STRS)

STRSIx Request RF sensor settings.

Example: STRS3
  

Response:
 

Ix=3; En=1; Ad=12345; Id=004; Th=1260; Tl=1250; Rh=060; Rl=050

• Ix = sensor index: 0 - 3

Notes:

• This command uses the same mnemonic as Assign RF Sensor Settings, but with 
fewer parameters.

7.1.5 - Restore Default Settings
 

This command restores all settings to their original factory-assigned states. 

The command format is defined below:

Command Syntax Comment

Restore Default 
Settings (SDS)

SDS There are no parameters associated with 
this command.

     

Example: SDS
     

Notes:

For a list of applicable settings, refer to Assign RF Sensor Settings,
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7.2 - Peripheral Activation
 

Peripheral activation commands are used for activating optional onboard peripherals 
including relay and/or piezo beeper. Available commands are listed below:

• Activate relay
• Activate beeper

7.2.1 - Activate Relay
 

The onboard relay (if equipped) may be used to activate an external device or specialized 
equipment. It can be commanded in one of two available methods: 1) activated for a 
timed duration, or 2) activated on or off for an indefinite period. The command format is 
defined below:

Command Syntax Example Comment

Activate Relay  !xxxxx  !00005 Activate relay for 5 seconds

 RELAY=n  RELAY=1 Activate relay (on)

Note: Onboard relay has a switching capacity of 10A @ 125VDC, 5A @ 100VDC

Field designators:

• xxxxx = 5-digit relay activation period in seconds
• n = activation designator: 0=off, 1=on

7.2.2 - Activate Beeper
 

The onboard piezo beeper (if equipped) may be used for audible annunciation and can be 
commanded in one of two available methods: 1) cyclically annunciate on and off for a 
specified number of reptititions, or 2) annunciate once for a specified duration. The 
command formats are defined below:

Command Syntax Example Comment

Activate Beeper  &nn  &15 Sound the beeper 1.5 seconds

 &xrrr  &x005 Cycle the beeper (on & off) 5 times

Field designators:

• nn = 2-digit value indicating the activation period in hundreds of milliseconds
• rrr = 3-digit value indicating the number of beeper repetitions to perform
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7.3 - Miscellaneous Commands
 

These commands have specialized purposes in the STRS. The following miscellaneous 
commands are available:

• Clear sensor states
• Get firmware version
• RF signal test

7.3.1 - Clear Sensor States
 

On occasion, it may be necessary to reset the STRS state machine, especially when 
settings changes are desired while a trigger activation is pending or in progress. This 
command cancels a trigger and resets the relay to its non-activated state. 

The command format is defined below:

Command Syntax Comment

Clear Sensor States 
(CLS)

CLS There are no parameters associated with 
this command.

     

Example: CLS
     

Notes:

Settings commands may require cleared sensor states. Refer to Settings Commands for 
details.
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7.3.2 - Get Firmware Version
 

This command reports a string containing the firmware version.

The command format is defined below:

Command Syntax Comment

Report firmware 
version (V)

V Request firmware version.

Example: V
  

Response:
 

STRS-1000,  v1.0,  [ 01/31/18 ]

7.3.3 - RF Signal Test
 

The RF signal test is an offline test intended only for testing and troubleshooting. Useful 
for evaluating RF signal strength, the command may be invoked by the host at any time. 
When invoked, the STRS controller identifies a received sensor signal by illuminating 
one or more red LED indicators. The number of active LEDs is an indication of signal 
quality. 

The command format is defined below:

Command Syntax Comment

RF Signal Test (RFSE) RFSE Enable (activate) RF signal test.

RF Signal Test (RFSD) RFSD Disable (deactivate) RF signal test.
     

Example: RFSE
     

Notes:

Normal operation ceases during RF signal testing. There will be no trigger activation 
until testing is disabled.
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8 - ASCII Data Messages
 

The STRS controller outputs unsolicited sensor data in standard ASCII format via RS-
232 (i.e., DB9 connector).  The output also includes trigger activation status and user-
specified limits (if applicable). All except the first field are represented in numeric or 
hexadecimal digits. Data messages contain the following:
 

• Trigger activation   status & limits
• Sensor channel
• Temperature and relative humidity
• Battery status

 

8.1.1 - Format
 

Data message strings are formatted as comma-separated fields:
 

    Tr, X1 X2 X3 X4 X5 X6 X7 X8 X9 X10 X11 X12 X13 X14,En,Th,Tl,Rh,Rl,Sm
 

• Tr – Trigger/relay status 
• X1 – X14 =  Sensor data, ASCII-formatted hexadecimal nibbles, 1 through 14
• En = Trigger processing: enabled/disabled (if disabled, limits are bypassed)
• Th = High temp. limit (5 digits), tenths deg.C, offset +100, 65535 = n/a
• Tl = Low temp. limit (5 digits), tenths deg.C, offset +100, 65535 = n/a
• Rh = High relative humidity limit (3 digits), 255 = n/a
• Rl = Low relative humidity limit (3 digits), 255 = n/a
• Sm = binary sum of all ASCII digits in the data string, truncated to two least 

significant digits and formatted in ASCII decimal

All transactions must be appropriately followed by a termination character:
   

Terminator

ASCII Text Numeric (Hex)

\CR 0D
  

The example below illustrates a complete data message and is shown in both ASCII text 
and numeric hexadecimal representations:
 

Message Example 
 

ASCII Text Numeric (Hex)

0,93024421096C6F,1,01266
,01211,055,045,26\CR

30 2C 39 33 30 32 34 34 32 31 30 39 
36 43 36 46 2B 31 2C 30 31 32 36 36 
2C 30 31 32 31 31 2C 30 35 35 2C 30 
34 35 2C 32 36 0D
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8.1.2 - Decoding
 

Host processing is necessary to decode incoming data message strings. The decode 
procedure is best explained in the following example message string:

0,93024421096C6F,1,01266,01211,055,045,26

Subsequent sections detail the parsing procedure for fields comprising the string.
 

 8.1.2.1 Trigger / Relay Status
 

Begin by deciphering the trigger/relay status indicator:

Trigger /Relay Status “Tr”:

• 0 = no trigger
• 1 = temperature trigger
• 2 = humidity trigger
• 3 = temperature and humidity triggers

Note:
 

• Temperature and/or relative humidity outside the range defined by high/low 
limits constitutes a trigger (relay) activation condition.
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 8.1.2.2 Measurement Data
 

The realtime measurement data is contained in a 14-character field, “X1” - “X14”:

93024421096C6F

Convert ASCII-formatted data from hexadecimal to binary:

Hex:

   93 02 44 21 09 6C 6F

Binary:

   1 0 0 1 0 0 1 1  0 0 0 0 0 0 1 0 
   0 1 0 0 0 1 0 0  0 0 1 0 0 0 0 1
   0 0 0 0 1 0 0 1  0 1 1 0 1 1 0 0
   0 1 1 0 1 1 1 1

Parse the binary string into individual data fields:

Ch Address Bt ID Humdity Temperature Checksum

10 010011 00000010 01 000100 00100001 00001001 01101100 01101111
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Ch - channel identifier (2 bits):

• A = 11
• B = 10
• C = 00

Address - logical address (14 bits)

Device address (unique for each sensor)

Bt - battery status

• Good = 01
• Low   = 10

ID - Identifier (6 bits)

Humidity - relative humidity (8-bits, msb is even parity bit)

0 0 1 0 0 0 0 1                      -- 8-bit composite value
   0 1 0 0 0 0 1 => 33% RH   -- 7 bits (parity bit stripped)

Temperature - temperature (16-bits, two msb's are even parity bits)

Raw byte values: 09 6C

0 0 0 0 1 0 0 1   0 1 1 0 1 1 0 0                  -- 16-bit composite value
  0 0 0 1 0 0 1      1 1 0 1 1 0 0                  -- 14 bits (parity bits stripped)
          1 0 0 1      1 1 0 1 1 0 0                  -- 11 bits (upper 3 bits unused)

               1 0 0 1 1 1 0 1 1 0 0  => 1260    -- integer value, raw temp measurement

                           1260 / 10 = 126.0    -- divide by 10.0
                           126 - 100 = 26.0 C   -- subtract 100, yields degrees C

                     (26.0 * 1.8) + 32 =  78.8 F  -- convert to degrees F

Checksum - error sum (8-bits, unsigned)

Modulo 256 computation on the previous 6 bytes.

In the sample message above, compute as follows:

93 + 02 + 44 + 21 + 09 + 6C = 16F   -- Take the sum
                               16F & FF = 6F     -- Mask the high bits, preserving 8 lower bits
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 8.1.2.3 Trigger Processing Indicator
 

Decipher the trigger processing indicator:
 

Trigger processing state, “En”:

• 1 = enabled
• 0 = disabled (see note)
• -1 =  indicates the sensor device is unknown to the STRS controller and 

therefore trigger processing is not applicable and limits are undefined.

Note:
 

• If trigger processing is disabled, limits are bypassed
 

 8.1.2.4 High Temperature Limit
 

When the actual temperature exceeds the specified high temperature limit, a 
trigger/activation is invoked. To convert the temperature limit, “Th”, follow the steps 
outlined below:

       1266 / 10 = 126.6    -- divide by 10.0
                126.6 - 100 = 26.6 C   -- subtract 100, yields degrees C

 (26.6 * 1.8) + 32 = 79.9 F   -- convert to degrees F

Notes:
 

• A limit value of 65535 indicates the limit is not defined (i.e., disabled)
• -1 indicates the sensor device is unknown to the STRS controller.
• Refer to Assign RF Sensor Settings for additional details.

 

 8.1.2.5 Low Temperature Limit
 

When the actual temperature falls below the specified low temperature limit, a 
trigger/activation is invoked. To convert the temperature limit, “Tl”, follow the steps 
outlined below:

       1211 / 10 = 121.1    -- divide by 10.0
                121.1 - 100 = 21.1 C   -- subtract 100, yields degrees C

 (21.1 * 1.8) + 32 = 70.0 F   -- convert to degrees F

Notes:
 

• A limit value of 65535 indicates the limit is not defined (i.e., disabled)
• -1 indicates the sensor device is unknown to the STRS controller.
• Refer to Assign RF Sensor Settings for additional details.
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 8.1.2.6 High Relative Humidity Limit
 

When the actual relative humidity exceeds the specified high relative humidity limit 
(“Rh”), a trigger/activation is invoked. (No conversion is necessary.)

       055 = 55% relative humidity

Notes:

• A limit value of 255 indicates the limit is not defined (i.e., disabled)
• -1 indicates the sensor device is unknown to the STRS controller.
• Refer to Assign RF Sensor Settings for additional details.

 8.1.2.7 Low Relative Humidity Limit
 

When the actual relative humidity falls below the specified low relative humidity limit 
(“Rl”), a trigger/activation is invoked. 

       045 = 45% relative humidity

Notes:

• A limit value of 255 indicates the limit is not defined (i.e., disabled)
• -1 indicates the sensor device is unknown to the STRS controller.
• Refer to Assign RF Sensor Settings for additional details.
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 8.1.2.8 Sum
 

This field (“Sm”) represents a summation of all characters in the data string (excluding 
the termination character). It provides a means for the host to verify that the string was 
received properly and without error. Refer to the example data string below:

0,93024421096C6F,1,01266,01211,055,045,71

To compute the sum, convert each digit and perform binary addition as shown below:

30 + 2C + 39 + 33 + 30 + 32 + 34 + 34 + 32 + 31 + 30 + 39 + 
36 + 43 + 36 + 46 + 2B + 31 + 2C + 30 + 31 + 32 + 36 + 36 + 
2C + 30 + 31 + 32 + 31 + 31 + 2C + 30 + 35 + 35 + 2C + 30 + 
34 + 35 + 2C 

= 7B3 (hexadecimal)

= 1971 (decimal)

 

Extract the lower two digits:
 
1971 % 100 = 71

Notes:

• Comma separators are included in the summation
• The terminating character is excluded from the summation
• The two sum characters (shown in bold, blue above) are excluded from the 

summation
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9 - Care and Maintenance

The product requires no special care or maintenance other than protection from direct 
exposure to the elements.  It is vital to shield the hardware from exposure to the elements, 
hazardous environments, and otherwise extreme conditions.   
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10 - Warranty

This product is warranted for a period of 1 year from the date of purchase and is 
guaranteed to be free from defects. The warranty covers the entire unit, except if any part 
or component has been modified or otherwise converted from its original form. The 
warranty does not cover damage or failure due to neglect, improper use, or unshielded 
exposure to moisture, power surges, hazardous environments and the like.

IMPORTANT: The customer is responsible to provide protection against potential over-
voltage situations including power surges, spikes, and lightning strikes.  The use of 
adequate surge protection is recommended.
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11 - Contact Information

Should you have any questions or comments please contact us :

Delahoussaye Consulting
http://www.kadtronix.com
support@kadtronix.com
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